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Grouping of Wireless Devices
1.1 General Information
Wireless receivers can be accessed individually or as a group of devices. When devices are accessed as a group, all devices
which are members of the group will receive an alert. Therefore, group access is very useful when multiple devices have to
be accessed and in order to provide alphanumeric, visual or audible alert to groups of users or different areas of the site. In
general, there are two methods to group devices:
1.

Simultaneous Access – multiple wireless devices are programmed with common ID (i.e., capcode) that is unique to the
group. As a result, when the system controller (VS4500, VS4810, VNS5100) is accessing that capcode, all of the
devices sharing that capcode will be activated simultaneously.
Grouping using common capcode provide fast access to all group members but on the other hand requires all groups
members (i.e., wireless receivers like pagers, VNS22xx, etc.) to be programmed with the common capcode assigned to
the group.

2.

Sequential Access – each individual device programmed in to the system controller (VS4500, VS4810, VNS5100) is
assigned as member of a group. When the group is accessed, the system controller iterates through the group
members and sends an individual alert to each one of the group members.
Grouping based on sequential access does not require the group members to be programmed with the group ID since
the access is performed using their individual capcode that is usually already programmed in to the system controller.
On the other hand, since each device is accessed individually, there will be a delay between the time when the first
member device receives the alert and the time when the last member device receives the alert.

In conclusion, simultaneous access grouping is faster and more efficient and can be used with all types of devices.
Sequential access may seem to be easier but is usually effective only when small number of devices is involved. In addition,
sequential access cannot be used in most cases when audible or visual alerts are required. Yet, it may be required when
multiple devices supporting different type of alerts (alphanumeric, visual, audible) have to be activated as a group.
1.2 Understanding Grouping and Zoning (Simultaneous Access)
In general, most wireless receivers (pagers, VNS22xx, alphanumeric display, etc.) can be programmed with 6 to 8 ID
(capcode). Wireless receivers are usually shipped programmed with an individual access capcode and a group capcode (i.e.,
All Call or Common capcode).
Therefore, most wireless receivers can be programmed with additional capcodes that represent a group or zone. When the
system controller is accessing that capcode, all wireless receivers programmed with that capcode will be activated using one
transmission from the system controller.
As a result, all wireless receivers can be members in multiple groups. For example, since the VNS22xx can be programmed
with 8 capcodes it can also be a member in up to 7 groups (assuming capcode 1 is used for individual access) such as All
Call, Building A, Building B, etc.
Each site may have tens of groups, but each wireless device can only be a member in number of groups equal to its
number of supported capcodes minus 1 (assuming capcode 1 is used for individual access). If only group access is
required, technically capcode 1 can also be used for group access.
Capcode (ID) is basically a seven digit number programmed in to each one of the wireless receivers and also in to the
system controller (VS4500, VS4810, VNS5100). When the system controller is required to access a device in its database, it
retrieves the device’s capcode and includes it in the transmission to the wireless receivers. When the wireless receivers
receive the transmission, they compare the capcode embedded in the transmission to all of the capcodes programmed in to
their memory. If the transmitted capcode matches any of the wireless receiver capcodes, it will process the alert and
generate the alphanumeric, visual or audible alert. Otherwise, the transmission is ignored and no alert is generated by the
wireless receiver.
1.3 Creating Groups (Simultaneous Access)
To access devices using group simultaneous access, please follow these steps:
1.

Identify the number of unique groups on the site. If required, use a site map and divide the wireless receivers to groups
based on physical or logical criteria.

2.

Assign each group with a unique capcode not used for individual or group access by any other device. We recommend
using capcodes that start with zero and have as less following zero as possible: For example:
Individual access (assuming there are 20 wireless receivers): 0 7 6 0 1 0 1 (first receiver) to 0 7 6 0 1 2 0 (last
receiver)
All Call Access: 0 7 6 0 9 0 4
Building A (Group 1): 0 7 6 1 1 0 0
Building B (Group 2): 0 7 6 2 1 0 0
Outdoor (Group 3): 0 7 6 3 1 0 0
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3.

Program each of the wireless receivers with the capcode assigned to its respective group:
For pagers programming, see Alphanumeric & Numeric Pagers on page 9.
For VNS22xx receivers, see Programming Wireless Receivers for Group Access on page 6.

Example of group assignment (20 wireless receivers)
All Call (0 7 6 0 9 0 4)
Group 1 – Building A (0 7 6 1 1 0 0)
Group 2 – Building B (0 7 6 2 1 0 0)
Group 3 – Outdoor (0 7 6 3 1 0 0)

Devices 19-20

Devices 1-18

Devices 1-8

Devices 11-16

Group 1
(0761100)

Group 2
(0762100)

Group 3
(0763100)

Device Number

Individual

All Call (0760904)

1

0760101

X

X

-

-

2

0760102

X

X

-

-

3

0760103

X

X

-

-

4

0760104

X

X

-

-

5

0760105

X

X

-

-

6

0760106

X

X

-

-

7

0760107

X

X

-

-

8

0760108

X

X

-

-

9

0760109

X

-

-

-

10

0760110

X

-

-

-

11

0760111

X

-

X

-

12

0760112

X

-

X

-

13

0760113

X

-

X

-

14

0760114

X

-

X

-

15

0760115

X

-

X

-

16

0760116

X

-

X

-

17

0760117

X

-

-

-

18

0760118

X

-

-

-

19

0760119

-

-

-

X

20

0760120

-

-

-

X
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Wireless Public Address (PA) & Bell Systems
2.1 General Information
The wireless Public Address (PA) or bell system consists of a system controller (such as VS4500, VS4810 or VNS5100), a
transmitter (internal or external) and antenna, wireless receivers (such as VNS2200 and VNS2210) and speakers. Each
VNS22xx receiver is wired to a speaker in the VNS2081 to VNS2085 models range.
The system controller can send a live voice message to the VNS22xx wireless receivers from the system microphone, or by
dialing in to telephone line connected to the system controller's phone jack (requires VS3003 option).
The system controller can also send a command to the VNS22xx receivers to play a pre-recorded tone or message stored in
their memory. The tone played by the VNS22xx receivers and the speaker connected to it can be one of the preprogrammed tones or can be customized to your preference by programming the VNS22xx with specific tone/s or voice
messages using the VPS software (see Programming Wireless Receivers with Custom Audio Alerts on page 7).
System controllers equipped with the VS2511 option can also activate tone or voice messages on the VNS22xx receivers
amplifiers based on a pre-programmed weekly schedule (supports 48 daily events).
Each VNS22xx receiver can be a member in up to 8 groups, so you can access devices individually or based on specific area.
See Grouping of Wireless Devices on page 3 and Programming Wireless Receivers for Group Access on page 6 for
more details.
2.2 Live Voice Speakers Test
To perform a simple test of the PA system, please follow these steps:
1. Make sure the system is properly set up and connected to the transmitter and antenna. Make sure the antenna is well
separated from the system and mounted vertically to a grounded metal surface. In addition, make sure the VNS22xx
receivers are powered and connected to the speaker/s. For additional details, please refer to the respective system and
receiver manual.
VS4500 Manual (www.visiplex.com/docs/vs4500man.pdf) - see section 1.7
VS4810 Manual (www.visiplex.com/docs/vs4810man.pdf) - see section 1.7
VNS2210 Manual (www.visiplex.com/docs/vns2210_Guide.pdf)
VNS2200 Manual (www.visiplex.com/docs/vns2200_Guide.pdf)
Visual Installation Guides (https://www.visiplex.com/product-installation)
2. PA devices are usually pre-programmed in to the respective system starting at Device 201 and up to the number of
receivers purchased. Device 200 is usually pre-programmed to access all PA devices (All Call / Site Wide Activation).
Note: If special grouping instructions were provided by the customer, please refer to the grouping worksheet.
3. To test a PA device, navigate to the respective system messaging menu (Page To menu on VS4500, Send Message on
VS4810).
4. Enter the appropriate device number using the keypad or keyboard and wait for the display to prompt with Speak Now.
Then, pick up the system’s microphone, press the PTT button and start announcing your message. The audio should be
heard through the PA speakers.
5. As live audio is being heard through the PA speaker, the LED status indicator will be continuously lit (solid) in Red or
Green to indicate that signal is being received.
a.

If you do not hear the live audio and the LED status light indicator is not continuously lit (solid), you might be out
of the effective RF coverage range. Consider relocating the wireless receivers closer to the system’s antenna or
relocate the antenna to a more central location. In addition, verify that accessed device is programmed as a PA
device.

b.

If the LED status light indicator is continuously lit (solid) but no audio can be heard, double-check the wiring
between the wireless receiver (VNS22xx) and the speaker. In addition, make sure the speaker is set to 8 ohm
impedance (if setting is available).

6. If the system is equipped with a telephone interface, you can also perform similar test by dialing in to the system:
a.

Connect an analog telephone line or extension (such as fax line) to the system controller’s Phone jack.

b.

Call the telephone number from a different telephone and wait for the system auto-attendant to answer your call.

c.

Follow the system prompt. For additional details, please refer to the respective system and receiver manual.
VS4500 Manual (www.visiplex.com/docs/vs4500man.pdf) - see section 3.4
VS4810 Manual (www.visiplex.com/docs/vs4810man.pdf) - see section 3.5
5

2.3 Weekly Bell Schedule Programming
To program the weekly bell and tone schedule, please follow these steps:
1. Make sure the system is properly set up and connected to the transmitter and antenna. Make sure the antenna is well
separated from the system and mounted vertically to a grounded metal surface. In addition, make sure the VNS22xx
receivers are powered and connected to the speaker/s. For additional details, please refer to the respective system and
receiver manual.
VS4500 Manual (www.visiplex.com/docs/vs4500man.pdf) - see section 1.7
VS4810 Manual (www.visiplex.com/docs/vs4810man.pdf) - see section 1.7
VNS2210 Manual (www.visiplex.com/docs/vns2210_Guide.pdf)
VNS2200 Manual (www.visiplex.com/docs/vns2200_Guide.pdf)
Visual Installation Guides (https://www.visiplex.com/product-installation)
2. Install the VPS software and USB drivers (see VPS on page 10). Verify communication between systems controller and
the PC.
3. Identify the ID of the device programmed in to the system controller (VS4500 or VS4810) representing the wireless
receiver/s to be activated.
4. On the VPS software, click on the menu button corresponding with your system model (VS4500, VS4810, etc.). Then,
click on the Weekly Bell & Tone Schedule menu item.
5. Verify that the Displayed Weekday field is set to Monday.
6. Select the event you wish to edit and click on Edit (or double-click on the selected event).
7. Refer to the product manual or software Help (press F1) for additional programming details.
VS4500 Manual (www.visiplex.com/docs/vs4500man.pdf) - see section 4.1.5
VS4810 Manual (www.visiplex.com/docs/vs4810man.pdf) - see section 4.1.5
8. Program the selected event. Please refer to the following general settings for basic test:
8.1 Time: enter the time of the day when the event should occur (i.e., tone activation)
8.2 Zone / Device ID: The ID of the device programmed in to the system (VS4500 or VS4810) representing the PA
receiver/s to be activated.
These system devices should be programmed as devices 001-099. Enter the last two digits of the designated
system device ID in the Zone / Device ID field.
Note: in standard system configuration, device 099 is pre-programmed in to the system controller for group
access using the common device ID assigned to the receivers. Enter 099 in this field to activate all VNS22xx
receivers.
8.3 Alert Type: Type of tone or alert that will be activated by the system. Alert 11 and up will activate a customized
user-programmed audio alert stored in the VNS22xx.
2.4 Programming Wireless Receivers for Group Access
1. Install the VPS software and USB drivers (see VPS on page 10). Verify communication between the VNS22x and the PC.
2. On the VPS software, click on the Wireless Devices menu. Then, click on the VNS2200 / VNS2210 Programmer
menu item.
3. Click on Read to retrieve the device information and verify communication.
4. Locate an unused capcode field (usually contains 0000000) under the Programmable Options section.
Note: In most cases, capcode 1 and capcode 2 are pre-programmed for Individual access and All Call group access,
respectively. As a result, the next available capcode is usually capcode 3.
5. Click on the check box to the left of the unused capcode (Program Capcode n, n is usually in the 2 to 8).
6. Type in the 7-digit capcode assigned to the group and Click on Program.
7. When the programming process is completed, disconnect the VNS22xx from the PC and test by activating it using one of
the newly programmed capcodes.
8. Repeat steps 3-7 for any additional VNS22xx receivers.
Note: make sure you read every receiver before programming to avoid overwriting existing data with data from
different receiver.
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2.5 Programming Wireless Receivers with Custom Audio Alerts
To program the VNS22xx receivers with customized audio alerts (WAVE audio files), please follow these steps:
1. Install the VPS software and USB drivers (see VPS on page 10). Verify communication between the VNS22x and the PC.
2. Prepare your customized alert files using Windows Sound Recorder (Windows XP only) or any other audio editing
software and save the files in the following format:
Format: PCM
Attributes: 8.000 kHz, 8 bit, Mono or 11.025 kHz, 8 bit, Mono or 22.050 kHz, 8 bit, Mono (version 3.05 and
higher only)
For demonstration purposes, below are the steps required to prepare the files using Windows Sound Recorder (available
on Windows XP only under Start Menu\Programs\Accessories\Entertainment):
2.1 Record or open a pre-recorded file (File, Open).
2.2 Click on File, Save As.
2.3 Enter a file name for the recorded or modified file.
2.4 Click on Change button.
2.5 Set Format to PCM.
2.6 Set Attribute to one of the following: 8.000 kHz, 8 bit, Mono or 11.025 kHz, 8 bit, Mono or 22.050 kHz, 8 bit,
Mono (version 3.05 and higher only).
2.7 Click on Save.
2.8 Repeat for all additional WAVE files.
Refer to the product manual or software Help (press F1) for additional programming details:
VNS2210 Manual (www.visiplex.com/docs/vns2210_Guide.pdf) - see Programming Custom Audio Messages
section
VNS2200 Manual (www.visiplex.com/docs/vns2200_Guide.pdf) - see Programming Custom Audio Messages
section
3. On the VPS software, click on the Wireless Devices menu. Then, click on the VNS2200 / VNS2210 Programmer
menu item.
4. Click on Read to retrieve the device information and verify communication.
5. Click on Alerts.
6. If required, change the Expanded Memory Alerts Configuration to match the approximate time of your longest
customized audible alert.
Note: The higher the number of alert, the shorter is the length (in seconds) of each alert.
7. Click on the first Program Alert check box and select the memory slot assigned to the alert (usually 11).
8. Click on Browse and browse to the location on the hard drive where the WAVE files is stored. Click on Open to select
the respective file.
9. Repeat steps 7-8 for any additional files.
10. Click on Program to upload the audio file in to the VNS22xx memory.
11. When the upload process is completed, disconnect the VNS22xx from the PC and test by activating the slot associated
with each one of the customized alerts (usually Alert 11 to 90).
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Wireless Clocks Systems
3.1 General Information
The wireless clocks system consists of a system controller (such as VS4500, VS4810 or VNS5100), a transmitter (internal or
external) and antenna and wireless analog or digital clocks.
The system controller is synchronized from time source such as GPS receiver or PC time. The time information is
transmitted to the clocks that correct their time according to the time received from the system controller.
3.2 Clock Synchronization and Coverage Test
1. Make sure the system is properly set up and connected to the transmitter and antenna. Make sure the antenna is well
separated from the system and mounted vertically to a grounded metal surface. For additional details, please refer to
the respective system and clock manual.
VS4500 Manual (www.visiplex.com/docs/vs4500man.pdf) - see section 1.7
VS4810 Manual (www.visiplex.com/docs/vs4810man.pdf) - see section 1.7
Visual Installation Guides (https://www.visiplex.com/product-installation)
2. Verify that the system clock is accurate and that it is set to your local time zone.
3. For systems using GPS receiver as time source, make sure there is a full colon (:) between the hour and minutes on the
systems clock (for example, 15:25).
If the system clock shows a dot (for example, 15.25), turn off the system and unplug the GPS receiver for 15 minutes.
Then, reconnect the GPS receiver and power on the system. Allow up to 30 minutes for the system to detect your GPS
receiver and verify that there is a full colon between hour and minutes.
For VS4500, see section 1.6 in the VS4500 manual for complete description of the display indicators.
4. For system using PC clock as time source, install the VPS software and USB drivers (see see VPS on page 10):
4.1 On the VPS software, click on the Settings menu. Then, click on the Configuration & Settings menu item.
4.2 Click on Synchronize Connected Device Clock to PC Time Automatically to activate automatic time updates
according to the PC clock.
Note: The VPS software must be running at all times to periodically update the system with the correct PC time.
5. Activate the time synchronization mode from the paging encoder:
VS4500 - press the C key while on the Page To menu. The screen should display SYNC IS ON.
VS4810 - press the F8 key while on the Main Menu. The bottom of the screen will display TIME SYNC IS ON.
6. Locate few Visiplex analog or digital clocks and refer to the clock manual.
Clock Installation Guide (www.visiplex.com/docs/clock_installation_guide.pdf) – see Activating the Clock section
6.1 If the clocks do not correct to the system time from their respective location, bring them closer to the system and
repeat the process.
6.2 If the clocks still do not correct to the system time, please contact Visiplex technical support.
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Alphanumeric & Numeric Pagers
4.1 VP-4 Alphanumeric Pager
The VP-4 is a 4 or 2 line pager capable of receiving full alphanumeric messages. The pager features and capcodes are
programmable using its keypad. More recent versions also support frequency programming using the pager’s keypad.
1. For pager programming information, please refer to the pager’s User Programming Guide:
VP-4 User Programming Guide (www.visiplex.com/docs/vp4_Guide.pdf).
2. For pager grouping information and concepts, refer to Grouping and Zoning on page 3.
4.2 VP-210 Alphanumeric Pager
The VP-210 is a 2 line pager capable of receiving full alphanumeric messages. The pager features, frequency and capcodes
are programmable using its keypad.
1. For pager programming information, please refer to the pager’s User Programming Guide:
VP-210 User Programming Guide (www.visiplex.com/docs/vp210_Guide.pdf)
2. For pager grouping information and concepts, refer to Grouping and Zoning on page 3.
4.3 VP-N Numeric Pager
The VP-N is a 1 line pager capable of receiving full numeric messages. The pager features, frequency and capcodes are
programmable using its keypad.
1. For pager programming information, please refer to the pager’s User Programming Guide:
VP-N User Programming Guide (www.visiplex.com/docs/vpn_Guide.pdf)
2. For pager grouping information and concepts, refer to Grouping and Zoning on page 3.
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Software
5.1 VPS
To install the VPS software and USB drivers, please follow these steps:
1. Log in to PC as user with administrator privileges.
2. Download the VPS software (www.visiplex.com/docs/vps_setup.exe)
3. Install the VPS software.
4. If USB connection is used, install USB drivers applicable to the Windows OS (x86 or x64, i.e. 32-bit or 64-bit) from the
shortcuts under the VPS program group.
5. Turn on the device (VS4810, VS4500, VNS22xx). Note: do not connect to the PC at this point.
6. Identify the COM number on the PC used for communication with the installed device:
6.1 If USB connection is used, open Windows Device Manager and expand the Port (COM & LPT) section. Connect
the device to the PC using the USB cable and note the COM number newly assigned to the installed device on
Windows Device Manager.
6.2 If standard serial connection is used (using DB9 cable), note the physical COM number on the PC. Connect the
device to the PC using the DB9 cable.
7. If VS4500 or VS4810 is used, set the serial port or USB port of the connected device to Visiplex protocol. If serial (nonUSB) connection is used, also set the port to 38400-8-N-1. Refer to the device manual for information on how to change
the device (VS4500, VS4810) serial port and USB settings:
VS4500 Manual (www.visiplex.com/docs/vs4500man.pdf) - see section 3.1.12 (COMn Protocol or USB Mode)
VS4810 Manual (www.visiplex.com/docs/vs4810man.pdf) - see section 3.4.3.3 (COMn & Set As or USB Mode)
8. Run VPS software and allow it to auto-detect the connected device and serial (COM) port used.
If communication cannot be established or faster connection initialization is preferred, configure the VPS to use assigned
COM port for communication with the device:
8.1 Click on the Settings menu.
8.2 Click on the Configuration & Settings menu item.
8.3 In the Serial Port drop down list, select the COM noted on step 6.
8.4 Clear the Auto Detect Connected Devices on Startup check box.
8.5 Click on Save.
9. If connection is successful, the information bar under the Settings menu will display the connection details.
10. Install the Help support update (for Windows 7 and up):
10.1 Click on the Help menu.
10.2 Click on Help Support Compatibility Download Link and follow instruction on the screen.
11. Refer to the product manual or software Help (press F1) for additional programming details.
VS4500 Manual (www.visiplex.com/docs/vs4500man.pdf) - see section 4.1
VS4810 Manual (www.visiplex.com/docs/vs4810man.pdf) - see section 4.1
VNS2210 Manual (www.visiplex.com/docs/vns2210_Guide.pdf)
VNS2200 Manual (www.visiplex.com/docs/vns2200_Guide.pdf)
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5.2 VNS2000
To install the VNS2000 software and USB drivers, please follow these steps:
1. Log in to PC as user with administrator privileges.
2. Locate the VNS2000 software you purchased.
(www.visiplex.com/docs/vns2000_server_setup.exe)

For

trial

version,

download

the

VNS2000

software

3. Install the VNS2000 software.
4. If USB connection is used, install USB drivers applicable to the Windows OS (x86 or x64) from the shortcuts under the
VNS2000 program group.
5. Turn on the device (VS4810, VS4500). Note: do not connect to the PC at this point.
6. Identify the COM number on the PC used for communication with the installed device:
6.1 If USB connection is used, open Windows Device Manager and expand the Port (COM & LPT) section. Connect
the device to the PC using the USB cable and note the COM number newly assigned to the installed device on
Windows Device Manager.
6.2 If standard serial connection is used (using DB9 cable), note the physical COM number on the PC. Connect the
device to the PC using the DB9 cable
7. VNS2000 can be used with COM1 or COM2 only. If the assigned COM port is other than COM1 or COM2, it will have to be
re-assigned as COM1 (recommended) or COM2:
7.1 Open Windows Device Manager.
7.2 Click on Ports (COM & LPT).
7.3 Verify that no other port is assigned as COM1.
7.4 Right click on the COM noted on step 6 and select Properties. Then, click on Port Settings – Advanced.
7.5 In the COM Port Number drop down list, select COM1 and click on Ok.
7.6 Click Ok again, close all windows and restart the PC.
7.7 After the PC has restarted, verify that COM1 is listed under Ports (COM & LPT).
8. Set the serial port or USB port of the connected device (VS4810, VS4500) to PC Admin protocol. If serial (non-USB)
connection is used, also set the port to 38400-8-N-1. Refer to the device manual for information on how to change the
device (VS4500, VS4810) serial port and USB settings:
VS4500 Manual (www.visiplex.com/docs/vs4500man.pdf) - see section 3.1.12 (COMn Protocol or USB Mode)
VS4810 Manual (www.visiplex.com/docs/vs4810man.pdf) - see section 3.4.3.3 (COMn & Set As or USB Mode)
9. Run VNS2000 software. click on Help – About VNS2000. If connection was established, the connected device model
and serial number will be displayed on the dialog box. Otherwise, configure VNS2000 to use assigned COM port for
communication with the device:
9.1 Click on the File menu.
9.2 Click on the Admin Login menu item followed by Ok (default password is blank).
9.3 Click on Setup menu. Them, click on System Configuration – Serial Port Settings.
9.4 Select COM001 and click on Edit.
9.5 Set the protocol to Local TX and match the Speed, Databits, Parity and Stopbits to the setting on the
connected device (VS4500, VS4810). These settings need to match the settings on step 8.
9.6 Click on Save followed by Close.
9.7 On the main screen, click on Help – About VNS2000. If connection is successful, the connected device model and
serial number will be displayed on the dialog box.
10. Install the Help support update (for Windows 7 and up):
10.1 Click on the Help menu.
11

10.2 Click on Help Support Compatibility Download Link and follow instruction on the screen.
11. Refer to the software Help (press F1) for additional programming details.

5.3 TimeSync
To install the TimeSync software and USB drivers, please follow these steps:
1. Log in to PC as user with administrator privileges.
2. Download the TimeSync software (www.visiplex.com/docs/timesync_setup.exe).
3. Install the TimeSync software.
4. If USB connection is used, install USB drivers applicable to the Windows OS (x86 or x64) from the shortcuts under the
TimeSync program group.
5. Turn on the device (VS4810, VS4500). Note: do not connect to the PC at this point.
6. identify the COM number on the PC used for communication with the installed device:
6.1 If USB connection is used, open Windows Device Manager and expand the Port (COM & LPT) section. Connect
the device to the PC using the USB cable and note the COM number newly assigned to the installed device on
Windows Device Manager.
6.2 If standard serial connection is used (using DB9 cable), note the physical COM number on the PC. Connect the
device to the PC using the DB9 cable.
7. Set the serial port or USB port of the connected device (VS4810, VS4500) to Visiplex protocol. If serial (non-USB)
connection is used, also set the port to 38400-8-N-1. Refer to the device manual for information on how to change the
device (VS4500, VS4810) serial port and USB settings:
VS4500 Manual (www.visiplex.com/docs/vs4500man.pdf) - see section 3.1.12 (COMn Protocol or USB Mode)
VS4810 Manual (www.visiplex.com/docs/vs4810man.pdf) - see section 3.4.3.3 (COMn & Set As or USB Mode)
8. Run TimeSync software and wait while the software detects the available COM ports on t the PC.
9. Install the Help support update (for Windows 7 and up):
Help Support Compatibility Download Link (http://support.microsoft.com/kb/917607)
10. Refer to the product manual or software Help (press F10 for additional details.
VS4500 Manual (www.visiplex.com/docs/vs4500man.pdf) - see section 4.2
VS4810 Manual (www.visiplex.com/docs/vs4810man.pdf) - see section 4.2
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Visual Installation Guides
6.1 General Information
The installation process is crucial to achieve proper operation and maximum benefits from the purchased equipments.
Please consult the respective product manuals and review the visual installation guides applicable to your products.
Visual Installation Guides (https://www.visiplex.com/product-installation)

Service Contact Information
7.1 Contact Information
For more information, or to obtain technical assistance on any warranty or non-warranty product, please write, call, fax or
email to:
Visiplex, Inc.
1287 Barclay Boulevard
Buffalo Grove, IL 60089
Phone: (847) 229-0250 or (877) 918-7243
Fax: (847) 229-0259
E-mail: support@visiplex.com
Website: www.visiplex.com
Business Hours: Monday-Friday, 9:00 AM - 5:00 PM Central Time.
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